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Notice to Reader

 

Canopus Corporation makes no warranty of any kind with regard to 
this material, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. Canopus shall not 
be liable for errors contained herein or for incidental consequential 
damages in connection with the furnishing, performance, or use of this 
material.

This document contains proprietary information which is protected by 
copyright. All rights are reserved. No part of this document may be 
photocopied, reproduced or translated into another language without 
the prior written consent of Canopus Corporation.

The information in this document is subject to change without notice.

 

Warranty

 

CANOPUS CORPORATION warrants that the enclosed PRODUCT 
MEDIA will be free from defects for ninety (90) days after purchase of 
the SOFTWARE. The SOFTWARE and any related documentation are 
provided “AS IS” and without warranty of any kind. CANOPUS 
CORPORATION specifically does not warrant that the SOFTWARE will 
run uninterrupted or error-free. The sole and exclusive remedy for a 
defect in the PRODUCT MEDIA is for Customer to notify CANOPUS 
CORPORATION of the defect in writing within the respective warranty 
period, to return the PRODUCT MEDIA to CANOPUS CORPORATION, 
and follow any other reasonable procedures which CANOPUS 
CORPORATION may establish. CANOPUS CORPORATION’s sole 
obligation shall be to provide Customer with a performing copy of the 
PRODUCT MEDIA within a reasonable time after receiving notification 
of the defect or to refund the purchase price and terminate this 
License Agreement, at CANOPUS CORPORATION’s option. The 
foregoing warranty does not apply if Customer mishandles, alters, or 
improperly uses or stores the PRODUCT MEDIA.
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CHAPTER 1
 Introduction

Thank you
Thank you for purchasing the Canopus Xplode Basics. Before you 
start using your system, please read this manual and follow the 
installation instructions. This ensures that you have a trouble-free 
setup. If you have any questions please call, fax, mail or email us at:

Canopus Corporation
711 Charcot Ave.

San Jose, CA 95131

Main telephone: (408) 954-4500

Main fax: (408) 954-4504

Technical support: (408) 954-4506

Website: www.justedit.com

Technical support e-mail: support@canopuscorp.com

About this manual
The information contained in this manual covers the installation and 
specific functionality of the Xplode Basics.

Chapter 1 — Introduction

Provides information about contacting us and using this manual.

Chapter 2 — Installation

Step-by-step on installing the Xplode Basics on your computer 
system.
www.justedit.com
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Chapter 3 — Preset Effects

Gives you information on how to use Xplode Basics and how to 
integrate it with other products.

Chapter 4 — Xplode Basics Transitions

Provides informative on how to use the Xplode Basics transitions.

Manual conventions
The following conventions are used throughout this manual:

• Bold usually indicates software menu commands

File > Open

• Italic is used for emphasis and naming

Trademarks
Xplode Basics is a trademark of Canopus Corporation. Premiere is a 
trademark of Adobe Systems. MediaStudio Pro is a trademark of 
Ulead Systems. All other trademarks and registered trademarks 
belong to their respective holders.
www.justedit.com
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CHAPTER 2
 Installation

To install Xplode Basics:

1. Insert the Xplode Basics CD in your CD-ROM drive.

2. When the installer screen appears, click on Install > Xplode 
Basics.

3. Click the Next button.
www.justedit.com
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4. Agree to the licensing terms.

5. Enter the serial number. The serial number can be found on 
the white envelope containing the Xplode Basics CD-ROM. 
You should keep the serial number in a safe place because 
you will need it in order to register the product and receive 
technical support.
www.justedit.com
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6. Choose a destination folder for the installation of Xplode 
Basics common components. The plug-ins and transitions 
are installed in the proper folders for your editing application.

7. Select which components you want to install. All compatible 
editing systems installed on your system appear in this 
dialog. Common Files must be installed and cannot be 
deselected.
www.justedit.com
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8. After installation finishes, Launch configuration utility box is 
checked. Click the Finish button. The Xplode Global 
Configuration window appears.

9. Select the appropriate 3D renderer in the drop-down menu 
that appears and press the OK button. Xplode Basics is now 
installed on your machine. The Xplode Basics suite will be 
available to you next time you launch your editing application.
www.justedit.com
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CHAPTER 3
 Getting Started

Overview
This section briefly explains how to use Xplode Basics within three 
popular editing applications.

The Xplode Basics configuration dialog has two main components, 
the Preview Window, where you can preview your transition, and 
the Configuration Tabs, where you can set a number of transition 
parameters.

NOTE: The Xplode Basics interface is identical regardless of 
the editing software you are using.
www.justedit.com
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Preview Window
The preview window shows you how a transition works and allows 
you to adjust its parameters.

There are three display options for each transition.

• Use Video Frames – uses images from the actual video 
footage to preview the tradition. If disabled, the default A and B 
graphics are used.

• Actual Duration – simulates what the transition will look like on 
the timeline at normal speed regardless of whether it needs 
rendering or not. However, you may still need to render the 
transition on the timeline before playback.

• Use Actual Frames – allows you to preview the transition with 
animated video frames from your source file. If this option is 
disabled, the first frame of Video A and the last frame of Video 
B are used as preview frames.

Change to actual video

Progress indicator

Displays preview in
actual duration

Video B
Video A

Actual Frames
option
www.justedit.com
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Above the Use Video Frames option, there is a Progress Indicator 
which displays the transition preview stage. While the transition is 
playing this indicator shows where in the transition certain events 
take place. You can adjust the transition movement using the Key 
Framer, in the Key Frames tab.

Presets
Presets are settings which can be used as templates in Xplode. 
When you develop a transition based on one of the Xplode families 
you can save the parameters in your own transition. This is useful 
when you use the same effect in many productions. Xplode ships 
with hundreds of presets.

To load a preset transition:

1. Click the Presets radio button.

2. Highlight the transition and click the Load button.

Preset Transitions

Select Group

Loads
Transition

Selected Transition
www.justedit.com
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Using with Canopus editing software
Canopus editing software are the standard editing packages which 
come bundled with Canopus hardware products. For more 
information on Canopus’ editing packages, please refer to the 
appropriate user manuals.

To experiment with Xplode Basics:

1. Start a new project by double clicking on the Canopus Edit 
icon in the editing system’s program group.

2. Double click in the DV Bin and open a few video clips.

3. Select Auto Arrange from the Edit pull-down menu. The 
clips appear in the timeline in the order they were imported 
into the DV Bin.

4. Right click on the boundary of the first and second clips and 
choose Transition in the menu that appears.

5. By default, a one-second cross-dissolve is inserted. Right 
click on the transition in the transition timeline.

6. Select Settings. 

Open transition

Render
transition

dialog
www.justedit.com
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7. Choose the Xplode BE - Fly Away in the Transitions dialog.

8. Click on the Shadow tab and make sure the Enable 
Shadows option is enabled. 

9. Click the OK button.

10.Click the OK button when the Transition dialog appears. 

11.Right-click on the red transition segment and click Render to 
render your effect. While the transition renders you will see 
the new video frames previewed on your VGA screen. 

12.Play the new segment by hitting the space bar.

Xplode transition families
www.justedit.com
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Using with MediaStudio Pro
To use Xplode Basics with MediaStudio Pro:

1. Open the MediaStudio Pro Editor and bring in two clips into 
the Va and Vb timelines.

2. Overlap the clips for a time duration.

3. Double click in the Fx track, select Transition Effect from the 
Production Library. 

4. Scroll down to the Xplode Basics transitions and double-
click on Xplode Standard.

5. Select Fly Away and drag it into the Fx timeline. 

Xplode plug-in

Xplode transition
double-click

to change settings.
www.justedit.com
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6. When the transition setting dialog opens click Options, the 
Xplode transition setting dialog appears.

7. Click on the Shadow tab and make sure the Enable 
Shadows option is enabled. 

8. Click the OK button.

9. Click the OK button when the Transition Options dialog 
reappears. 

10.To view your transition, choose View > Preview. 

11.Play the new segment by hitting the space bar.

Click the Options button
to open the Xplode software
www.justedit.com
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Using with Adobe Premiere 6.x
To use Xplode Basics with Adobe Premiere 6.x:

1. Open Adobe Premiere and bring in two clips into the Video 
1A and 1B timelines. 

2. Overlap the clips for a time duration.

3. Click on the Transitions palette and double-click on the 
Xplode - Standard folder.

4. Drag the Xplode BE - Fly Away transition into the transition 
timeline. 

5. Double click on the transition to open the Xplode transition 
setting dialog.

Xplode transition
double-click to

change settings

Xplode transition families
www.justedit.com
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6. Click on the Shadow tab and make sure the Enable 
Shadows option is enabled. 

7. Click the OK button to close the Transition Settings dialog. 

8. Press the Enter key to render the transition. If you haven’t 
previously saved your project, you will be prompted to save it 
before Premiere begins rendering.
www.justedit.com
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CHAPTER 4
 Transition and Effect Settings

This section will explain the Xplode Basics interface and how to 
customize transitions and effects.

Xplode Global Configuration
The Xplode Global Configuration utility allows users to change the 
render mode and overscan handling on all transitions at one time. 
You can also choose which 3D renderer, either hardware or 
software, you want to use to render your transitions.

Render Mode
The Render Mode tab allows you to select from four different render 
modes with varying degrees of image quality. This allows you to 
preview effects at lower resolutions to help save rendering time while 
you are still editing your project.

• Highest Quality – renders your effects at the highest quality 
possible. This is Xplode Basics’ default setting. It’s generally 
safe to use this setting if you are using hardware acceleration 
or have a very fast computer. For more information on 
hardware acceleration, see 3D Render on page 19.

• Draft – renders your effects without anti-aliasing at full 
resolution, which helps speeds up software-based rendering.

• Preview – renders your effects with slight optimizations at 1/4 
full-size resolution. 

• Fastest – renders your effects without any optimizations at the 
lowest possible resolution. This setting is best used for 
computers with slower processors.
www.justedit.com
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Overscan Area
The overscan area are the black edges around the perimeter of most 
captured video. For professional results, this area needs to be 
cropped for proper viewing on a television. Use the Overscan Area 
tab to manually configure the overscan area’s borders. 

Typically, you will use Automatic Overscan Area, which is the 
Overscan Area tab’s default preset. You can manually configure 
these parameters if you choose, but this is only recommended for 
advanced users.

Global overscan handling is only available to transitions that have 
overscan handling enabled in each transition’s General tab.

In the Type drop-down menu, there are a total of five presets.

• Overscan Handling off — disables overscan handling. If you 
disable this in the Xplode Global Configuration utility, then the 
Enable overscan handling option in the individual transition’s 
General tab are non-functional.

Turning off overscan handling globally allows you to disable it 
for all transitions if you are creating a video for the web, and 
then enable it again when you are creating a video for 
broadcast.

• Automatic Overscan Area — depending on the video format, 
the overscan is set to the standard values for that format.

• Automatic Overscan Area with pixel adjustment — is the 
same as above, except you can add additional pixel 
adjustments. This allows you to make customized adjustments 

The General tab in the individual transition window.
www.justedit.com
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to the default presets. This should only be used by advanced 
users.

• Absolute Overscan Area in pixel — allows you to set an 
absolute overscan area in pixels. This should only be used by 
advanced users.

• Relative Overscan Area in % frame size — allows you to set 
an overscan area in percentages of the frame size instead of 
pixels. This should only be used by advanced users.

3D Render
This tab lets you choose a 3D renderer, either hardware or software, 
to use to render your transitions.

The drop-down menu only displays the 3D rendering options 
available on your machine. If your video card supports Xplode’s 3D 
hardware acceleration, then you can choose between the hardware 
or the software D3D Universal Renderer. To see if your video card is 
compatible with Xplode’s 3D hardware acceleration, go to the 
Canopus website at http://www.justedit.com/.

Configuring for 24-bit graphics
If you are using a system that uses a 24-bit graphic chip, such as an 
Intel 810/815:

1. Select the D3D Universal Renderer from the drop-down 
menu.

2. Click the Config button. The 3D Render Options dialog 
appears.

3. Select RGB Emulation.

This procedure not only improves performance, it also prevents 
Xplode from automatically searching for a renderer every time your 
editing application starts up.
www.justedit.com
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Configuration and Customizing
The Xplode Basics Configuration section is where you can 
customize and save your own presets. With this functionality you can 
compose an unlimited number of effects.

Depending on which transition you choose there are a number of 
options you can set to customize your effect. Once you customize 
an effect, you can save the transition as a preset for use in future 
productions. Although each transition has its own specific options, 
most of the configuration tabs are common to all effects. An 
overview of the different configuration tabs follows

Configuration Tabs
www.justedit.com
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Custom transitions
Once you make a change to a transition, you may save it for future 
use. When you want to save a transition configuration check the 
Custom option, enter a transition name in the Name field and click 
the Save button.

To load a custom transition select the Custom check box, highlight 
the transition and click the Load button.

To rename a custom preset:

1. Click on the preset you want to change.

2. Re-name it and click the Save button.

3. Click the original preset and click the Delete button.

Custom toggle

Presets
www.justedit.com
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Key Frames tab
Key Framing is an animation technique which refers to key anchor 
points defining where movements begin and end. In Xplode Basics, 
key frames refer to video frames which define the starting and 
ending points of a transition movement. 

For example, to have the Double Door transition open to a position, 
stay open for a period of time and then close, you need to add key 
frames to the movement points. One key frame defining the point to 
where the door opens, another key frame to the point where the door 
starts to close.

The key framer has a timeline graph which by default has a key frame 
at the beginning and end of the transition. The transition moves from 
the 0% (Video A) mark to the 100% mark (Video B).The slider on the 
key frame timeline moves the transition through its movement. 

Keyframe “map”

Percent of transition

Timeline slider
www.justedit.com
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Adjusting Key Frames
To add a key frame, move the timeline slider to a position and click 
the Add-key button, this adds a key frame to the timeline. An active 
key frame, the key frame where the slider is currently positioned, is 
green. At the right side of the slider a frame number box denotes the 
current frame. You can jump from key frame to key frame using the 
jump-to-key frame buttons. 

To adjust the degree of transition on a key frame move the % of 
Transition slider. You can also add the percentage manually in the 
% of Transition box. To display how the transition moves click the 
Play button. When you render your transition the key frame settings 
will be used in your final transition.

To delete a key frame, position the slider over a key frame marker, it 
will turn green, select delete key.

NOTE: Key frame markers can be adjusted by clicking on 
them and sliding them to a new position.

Play new

Add keyframe

Remove keyframe

Previous keyframe

Next keyframe
keyframe motion
www.justedit.com
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Using Keyframe Preset Motions

In the example above, the alpha transition is ‘paused’ halfway 
through the transition. The teeth in this example close showing both 
Video A and B and remain closed for a period of time. You can adjust 
this preset by using the mouse and dragging the keyframe around 
the keyframe graph.

“Pause” 
www.justedit.com
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Types of Key Frames

In the same transition as in the previous example, we loaded the 
Slow down preset, which slows the transition at its end. By 
choosing Ease In in the Type drop-down menu, a more organic 
movement is achieved.

“Ease” 
www.justedit.com
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Adjusting and Saving your own Key Frame settings

After you modify a preset or create a new preset, you can save it to 
the preset list. Enter a new name in the Preset area and click the 
Save button. The preset will be available for future use.

Custom movement

Enter new
preset name

Click Save
to save the 
preset
www.justedit.com



CHAPTER 4: Transition and Effect Settings 27
Background tab
The background tab allows you to choose a background to use 
during a transition. This tab is only available in transitions where the 
background doesn’t have to be Video A or B.

To select a single color background:

1. Click the Color button.

2. To select a new color click the Change button. The Color 
dialog appears.

Use image as background

Use background color

Use video as background

Use either Video A or B
as background

Change
www.justedit.com
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3. Select a color and click the OK button.

To choose a bitmap (BMP):

1. Click the Bitmap button.

2. To select a bitmap file, click the Change button.

3. Select a graphic file in the Windows dialog that appears.

4. If you want to make any changes to the graphic file, click the 
Advanced button to access additional options available to 
process your bitmap.

Use the color-picker to
select a background color

Slide direction

Slide speed

Keep Aspect
Ratio
www.justedit.com
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You can choose to have these backgrounds slide in various 
directions in the background. Xplode Basics comes with artwork, 
including seamless backgrounds which appear to be endless when 
they are moving.

You can adjust the speed of the slide by moving the speed slider to 
the right.

Video clip placement
To adjust a video clip as a background you have the option of fitting 
or justifying either end of the clip.

 Fit background video clip into transition duration – This fits a 
background video clip into the transition duration. 

For example, a 2-second clip will be fit into a 1-second transition. 
This will make the background play in higher speed than the original 
background video.

 Left justify the video clip to the left – This takes an equal 
amount from the first part of the background clip and use it as the 
background. 

Video playback
in background
adjustments

Video clip placement
www.justedit.com
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For example, if a transition is one second long and a background clip 
is 2 seconds long, then the first second of the background clip is 
used as the background.

 Center justify the video clip – This takes an equal amount from 
the center part of the background clip and use it as the background. 

For example, if a transition is 2 seconds long and a background clip 
is 10 seconds long, then the middle 10 seconds of the background 
clip, second of the background clip is used as the background.

 Right justify the video clip to the right – This will take an equal 
amount from the last part of the background clip and use it as the 
background. 

For example, if a transition is one second long and a background clip 
is 2 seconds long then the final 1 second of the background clip will 
be used as the background.

Render Fields
Render Fields is used if your source contains video fields, such as 
footage that comes from a video camera. If you are using 
progressive footage, you should disable this option.

Loop
The Loop option is used if your source video is shorter than your 
transition. It allows the video to continuously play instead of starting 
or stopping in the middle of the transition.
www.justedit.com
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General Tab
The General tab options will vary from transition to transition. The 
options will usually refer to rendering, overscan and anti-aliasing 
options. 

Render with trails
Video trails are remnants of previous video frames left on the screen. 
The effect looks like smearing video.

Apply anti-alias filter to transition
Anti-aliasing removes diagonal ‘jaggies’ on diagonal lines. Xplode 
Basics anti-aliasing smooths in both the vertical and horizontal 
directions. If you use anti-aliasing, your rendering time may increase 
depending on your renderer.

Add video trails

Add anti-aliasing
www.justedit.com
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Enable Overscan Handling
If enabled, effects will not render outside of active scan area. For 
more information, see Overscan Area on page 18.

Render in reverse order

Some transitions allow you to change the default direction of the 
setting by enabling this option.

For example, the Zoom transition’s default is for Video A to zoom 
into Video B by making Video A progressively smaller. Enabling this 
option makes Video A zoom from smaller to progressively bigger.

Options Tab

Position control (Ripple, Zoom)
Some of the transitions allow you to set a specific position on the 
video where the effect will occur. To do this:

1. Click on the target selector.

2. Click on the preview window where you want the transition to 
be placed. You will now see that the transition’s placement 
has been changed.
www.justedit.com
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Target selector
www.justedit.com
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Light tab

• Color changes the color of the light. Click the Choose button 
to select a new color.

• Ambient changes the amount of ambient light in the scene.

• Glare changes the amount of glare on the video.

• Position moves the light icon in the grid to determine which 
direction the light source is coming from.
www.justedit.com
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Shadow tab

• Visibility changes the opacity of the shadow.

• Color changes the color of the shadow.

• Soft Border makes the edges of the shadow fade out. This 
option may not be available for all transitions.

• Size changes the size of the shadow. This option may not be 
available for all transitions. 

• Virtual Light Position allows you to set the position of the light 
source when creating shadows. This does not cast any light on 
the scene but rather determines the position of the shadows 
cast by the moving object. 

For example, if you set the Virtual Light Position to the left side 
of the grid, the transition’s shadows appear on the right side of 
your video. If this option is not in the tab, the shadow is created 
using the light position set in the Light tab.
www.justedit.com
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CHAPTER 5
 A Detailed Look at Xplode Effects

Xplode Basics transition families have a number of basic tools to 
develop a large number of custom transitions. The custom 
transitions can be saved as new transitions for use in future video 
productions. Xplode ships with hundreds of preset transitions to help 
you get up to speed quickly. The following section describes each 
transition family in detail.

Xplode Parameters
Within all the Xplode transitions there are a number common settings 
and parameters. This chapter will provide an overview of all of the 
transition families and the transition presets they contain.
www.justedit.com
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3D Object Wipe

The 3D Object Wipe transition uses a 3D object to wipe Video B over 
Video A. The texture of the object may include changes to Video A, 
Video B, a bitmap image or color.

Options tab
• Direction sets the path that the object will pass through the 

scene.

3D Object

Video A

Sets direction
of 3D object wipe
www.justedit.com
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Object tab

• Spin determines the direction of the 3D objects spin as well as 
the number of spins.

• Rotate Vertical changes the objects position from horizontal 
to vertical.

• Flip Object mirrors the object.

• Tilt rotates the object around to view any point on the object.

• Custom allows 3D objects to be imported into Xplode 
Basics.You can import 3D objects from Lightwave plug-ins or 
3D Studio Max using the 3D Compiler utility included on the 
Xplode Basics CD-ROM. 

Texture tab
Some presets allow you to change the texture of the element by 
replacing the default with Video A, Video B, a bitmap image or an AVI 
video. To replace the original texture:

1. Click the Presets tab and choose Heart - Wipe Down and 
click the Load button.

2. Click the Textures tab.

3. Click the Replace option on line 1 to enable it

4. Click the Advanced button. The preview window expands.

Determines spin
direction

Changes 3D objects
orientation

 

Select
custom object

Sets number
of spins
www.justedit.com
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5. In the Replace With section, click on one of the radio buttons 
to choose Video A, Video B, Bitmap or AVI. Choosing Video A 
or Video B simply replaces the texture with the respective 
video file. If you choose Bitmap or AVI, you need to click on 
the ... button to select a bitmap or video file that will replace 
the current texture. After you choose a file, the preview 
changes to reflect the change.

6. Click the OK button. The 3D Object Wipe will have a new 
texture applied to it.

Alpha Wipes and Dissolves
Alpha Wipe transitions consist of Video A wiping into Video B using 
Alpha Wipe maps.

Orientation Tab
• Flipping changes the direction of the wipe in the transition.

Video A
Video B

Flips direction
of wipe

Sets direction 
of wipe

Preview
www.justedit.com
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• Rotation determines the orientation of the wipe.

Alpha Map Tab
• Sharpness sets the intensity of the transition. The higher the 

setting the more distinct the transition appears in the scene.

• Acceleration adjusts the amount the animation accelerates 
over the duration of the transition. This does not effect the 
duration of the transition, only the speed of the dissolve itself.

3D Transitions Effects
The 3D Transitions Effects consists of 8 transitions with an 
abundance of presets to add elegance and artistry to any video 
production.

Ball Bounce
Video B bounces into Video A on a bouncing ball.

Number of Bounces

Highlight

Depth

Start Position

Ball Elasticity
www.justedit.com
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Options tab
• Number of Bounces determines how many times the ball will 

bounce.

• Depth sets the “distance” at which the ball first appears.

• Highlight regulates the amount of glare on the ball.

• Ball Elasticity sets the amount that the ball will flex as it 
bounces.

• Start Position sets where the ball will enter the picture. “0” is 
far left, “100” is far right.

Cube Tube
Cube Tube moves from Video A to Video B by mapping Video A and 
Video B on opposite sides of an open-sided box. The box is rotating 
back in space.
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Options tab
• Depth determines the depth you want the tube to fly back into 

space.

• Soft Border makes the object fade out at the edges.

Double Door
Video A splits into two doors and reveals Video B.

Options tab
• Direction determines if the double door is horizontal or 

vertical.

• Soft Border makes the object fade out at the edges.

Various door pivots

Adds a soft border
to a scene change
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Fly Away
Video A scales and rotates in 3D space then accelerates off-screen 
revealing Video B.

Options tab 
• Path Options (Bank, Straight) sets whether the 3D video plane 

moves in a straight line or banks to the into the direction that it 
is flying. The Pause option pause the fly away briefly before it 
continues on its path.

• Depth determines how far back in 3D space the effect occurs.

• Pause sets the time the frame “hangs” in space before 
zooming off screen.

• Fly To selects where the 3D video plane flies.

• Soft Border makes the object fade out at the edges.

• Glare lets you adjust how much glare appears on the object.

Motion path type

Depth of 3D transition

Direction of fly-away

Glare

Soft Border
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Edge tab

• Use Edge allows you to modify the size of the edge. Enabling 
this option lets you add a bitmap or color to the edge of the fly 
away object.

• Use Edge Bitmap allows you to use a bitmap image instead of 
a color on the edge. This allows you to enhance the edge of the 
3D transition with your own bitmap file. This option disables 
the Edge Color option.

• Edge Color lets you choose a color for the edges. The default 
edge color is gray. Click the Color Setting button to choose a 
color from the Color dialog. This option is only available when 
Use Edge Bitmap is disabled

NOTE: If an edge is enabled, the Soft Border option is 
automatically disabled.

Edge parameters
www.justedit.com



CHAPTER 5: A Detailed Look at Xplode Effects46
Page Peel
Like turning the page in a book, Page Peel turns Video A to Video B. 

Options tab
• Accelerated peel adjusts the amount the peel accelerates 

over the duration of the transition.

• Roll instead of peel will roll the pages rather than peel them.

• Enable light adds specular lighting.

• Radius determines the circumference of the page as it peels or 
rolls.

• Soft Border makes the object fade out at the edges.

• Peel Direction determines the angle of the peel.

Roll pages instead of peel

Peel acceleration

Enable light

Peel angle

Determines radius of page

Soft Border
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Ripple
A ripple on still water effect transitions Video A to Video B. 

Options tab
• Ripple Frequency sets the intensity of the ripple.

• Ripple Density determines the number of rings in the ripple 
effect.

• Start from the center sets the starting point of the ripple to 
the chosen center position. Otherwise, the ripples appear 
everywhere at the same time.

• Center Position places the center of the ripple to any location 
on the frame that you choose. You can modify the center 
position of the ripples by entering values in the Center Position 
fields or by clicking on the target selector button and clicking 
on the desired center position in the frame.

• Light Options add shading and lighting effects to the ripple. 
You can also select the direction of the specular lighting effect.

• Extinct Rippling stops the ripple as the transition ends 
causing it the final ripple to disappear off the edge of the frame.

Ripple Frequency

Ripple Density

Dissolve timing

Extinct rippling
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Wave
Video A “waves” slowly, speeds up and changes to Video B.

Options tab
• Amplitude determines how “high” the wave becomes.

• Direction sets the direction of the wave movement.

• Frequency sets the number of waves in the transition.

• Number of Tiles sets the number of tile pieces used in the 
wave.

• Delay sets the speed of wave motion.

Rippling wave effect
over a background bitmap

Sets height
of wave

Direction of 
movement

Number of 
waves

Sets number 

horizontal
of tiles

and vertical
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Zoom

Description
Video A pulls away from Video B on a Picture in Picture.

Options tab
• Position changes the location of the zoom’s end position.

• Rotation determines the number of spins in the transition. 
Both on the X and Y axis. 

• Accelerated Movement adjusts the amount the zoom 
accelerates over the duration of the transition.

• Glare on the Video lets you adjust how much glare appears on 
your video.

Sets the position

Sets rotation

Sets speed

of the zoom

of zoom

of movement
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Border tab
• Style lets you choose between a Flat, 3D or Soft Border. If you 

choose Soft Border, you can only configure its thickness.

• Size determines the thickness of the border

• Color determines the color of the border.

Adds 3D border

Border color selector

Size of border
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